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Welcome!
Thank you for trying out Reason Lite!

Reason Lite is a “light” version of the music production tool Reason. Reason Lite is easy to get started with, 
yet as deep as you want it to be.

The included set of instruments, effects and sounds is everything you need to get started making music. 
Then polish your work to perfection with Reason Lite's state-of-the-art recording and mixing tools. Reason 
Lite actually features the same fully featured and well-renowned mixer as Reason!

Reason Lite 11 adds a number of workflow enhancements in the sequencer, such as curved automation, 
multiple notes drawing and muting of individual notes - plus crossfading of audio clips. Reason Lite 11 also 
lets you use the Reason Lite Rack as a plugin in another VST3/AUv2/AAX compatible DAW.

Don't forget to visit the Reason Studios web site at www.reasonstudios.com and read up on all the new 
Rack Extension instruments and effects created by ourselves and others that you can add to your rack.

Yours truly,

The Reason Studios Team

www.reasonstudios.com

About the Reason Lite 
documentation
This is the Installation Manual where installation of Reason Lite and basic setting up procedures are 
described. Detailed features and operations in Reason Lite are described in the Operation Manual pdf and 
in the on-line Help system. The Operation Manual and Help also contain reference descriptions of all 
Reason Lite devices and commands.

About operating system versions
Reason Lite runs under macOS and Windows (for operating system details, see “Requirements”) and only 
supports 64-bit operating system versions. All Reason Lite packages contain program versions for both 
platforms. Everything said in the manuals applies to both platforms, unless explicitly stated.

The Reason Lite download version
The download version of Reason Lite contains the complete product contents. When you have 
downloaded the program package and installed the program, all you have to do is register and authorize 
the program and you are good to go. Refer to “Registering Reason Lite” and “Running Reason Lite with 
Internet Verification” for details.

http://www.propellerheads.com
http://www.propellerheads.com
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Requirements
Below you will find the minimum requirements for running Reason Lite:

! Note that these are the minimum requirements! You will benefit from a fast computer 
with lots of RAM, since this will allow you to use more devices at the same time.

macOS
• Fast and stable Internet connection for installation and registration required!
• Intel Mac with multi-core processor
• 4 GB RAM (8 GB or more recommended for large Rack Extensions)
• 4 GB free system disk space required. Additionally, the program may use up to 20 GB 

scratch disk space
• macOS 10.11 (El Capitan) or later (64-bit)
• Monitor with at least 1280x768 resolution
• CoreAudio compliant audio interface or built-in audio hardware
• MIDI interface and a MIDI keyboard recommended
• For using Reason Lite as a Plugin, a DAW host with VST3/AUv2/AAX support is required

Windows
• Fast, stable Internet connection for installation and registration required!
• Intel or AMD multi-core processor
• 4 GB RAM (8 GB or more recommended for large Rack Extensions)
• 4 GB free system disk space required. Additionally, the program may use up to 20 GB 

scratch disk space
• Windows (7)/8/10 (64-bit)
• Monitor with at least 1280x768 resolution
• Audio Interface with ASIO driver
• MIDI interface and a MIDI keyboard recommended
• For using Reason Lite as a Plugin, a DAW host with VST3/AAX support is required
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About the Audio Hardware
The audio hardware is the computer equipment that converts the analog signals from instruments and 
microphones to digital signals that Reason Lite can work with and store, and back again (for connection to 
an amplifier, headphones, or similar). This equipment could be a built-in audio card, a USB interface, a 
Firewire audio interface, or an audio card with several inputs and outputs, digital connectors, etc. 
Regardless of which, you need to make sure the hardware and its drivers are properly installed:

Audio hardware and macOS

If you are using the built-in audio hardware in your Macintosh

All Mac models come with a built-in audio interface, providing stereo input and output jacks (and in some 
cases a built-in microphone). Depending on your needs, the quality of these inputs and outputs may be 
fully sufficient for use with Reason Lite. 

If you are using other audio hardware with your Macintosh

You may want to use other audio hardware with Reason Lite (e.g. an audio interface with multiple outputs, 
digital connections, etc.). For this to be possible, the audio hardware must be compatible with macOS, i.e. 
there must be a Core Audio driver available for the hardware.

1. Install the audio hardware drivers as described in its documentation.
Note that some audio hardware does not require any special audio drivers. Please, refer to the hard-
ware documentation.

2. Connect the stereo outputs of your audio hardware to your listening equipment (speak-
ers, mixer, headphones or similar).
For info about how to use multiple outputs (i.e. more than a stereo output), see the Operation Manual 
pdf. For now, we stick to standard stereo connections.

3. If possible, test that audio plays back OK with the audio hardware.
With some audio hardware, a test application is supplied for this purpose.

Audio hardware and Windows
! To run Reason Lite with full audio in and audio out functionality under Windows, an ASIO 

driver is required for the audio hardware.

Reason Lite can run with DirectX or MME drivers as well but this will only support audio out - and at 
considerably higher latencies than with ASIO drivers.

1. Make sure you have the latest ASIO driver for the audio hardware!
Please check the manufacturer's web site for the latest versions.

2. Install the audio hardware drivers as described in its documentation.

3. Connect the stereo outputs of your audio hardware to your listening equipment (speak-
ers, mixer, headphones or similar).
For information about how to use multiple outputs (i.e. more than a stereo output), see the Operation 
Manual pdf. For now, we stick to standard stereo connections.

4. If possible, test that audio plays back properly with the audio hardware.
In the case of audio hardware with ASIO drivers, you will need some test application for this (often in-
cluded with the audio hardware).
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About MIDI Interfaces
While it is possible to use Reason Lite without an external MIDI controller (by only using the “On-screen 
Piano Keys” window for playing MIDI notes, or by manually drawing notes and automation in the 
sequencer), this would not allow you to use the program to its full potential. From now on we assume that 
you are using a keyboard controller - either a USB keyboard with a built-in MIDI interface, or a separate 
MIDI interface and a MIDI keyboard.

D When installing the keyboard controller, or MIDI interface and its drivers, follow the in-
structions in its documentation carefully.

• While a MIDI interface with a single MIDI port is sufficient, you will benefit from having 
two or more individual MIDI ports.
This is especially true if you want to manipulate Reason Lite parameters with additional MIDI control 
surface devices, or use the program in conjunction with an external, stand-alone sequencer, drum ma-
chine or similar.

• For some MIDI interfaces connected via USB, no driver installation is required. Just plug 
in the interface and you're ready to go!

• For other, more advanced MIDI interfaces (or at least to take advantage of more ad-
vanced features, like multiple inputs) you will need to install a driver.
Please consult the documentation that came with the interface for details.

MIDI In Connections
D Simply connect the USB cable from your keyboard to your computer.

Or

D Connect a MIDI cable from the MIDI Out on your MIDI keyboard (or other MIDI controller) 
to a MIDI In on your MIDI interface.
This is sufficient to be able to play and record notes and controllers in Reason Lite from the MIDI key-
board.

• If you are not using a USB keyboard, you may also connect the MIDI Out from the MIDI in-
terface to the MIDI In on your MIDI keyboard.
This is not strictly necessary to use Reason Lite, but it will enable two-way communication when you 
run the Reason Lite Setup Wizard which appears the first time Reason Lite is launched (see “First run 
- Reason Lite Setup Wizard”), or when using Auto-detect Surfaces in the Preferences (see “Adding a 
specific Control surface”). Whether auto-detection works or not depends on the keyboard model.

! If you have several MIDI control surfaces or similar that you want to use, we recommend 
that you connect them to separate MIDI ports (or directly to the computer using USB).

MIDI Out Connections
If you have external synthesizers, drum machines or other devices that can be played via MIDI, you can 
control them from Reason Lite. For this you need to have a MIDI interface with one or several outputs. 

D Connect a MIDI cable from a MIDi Out jack on the MIDI interface to the MIDI In jack on 
your external instrument.
Read more about how to control external MIDI devices from Reason Lite in the Reason Lite Operation 
Manual.pdf or Reason Lite Help in the program.
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Installing the Software
Installing Reason Lite
D Unzip the downloaded zip file (Windows) or mount the disk image file (macOS).

What to do next depends on whether you are installing on a Mac or a Windows computer.

Windows:

1. Locate the file called “Install Reason Lite 11.exe" and double click it.

2. Follow the instructions on screen.
Before executing the installation of the software components, you will be asked to select a language, 
an install location, and whether you wish to create a program shortcut/alias on your desktop. When the 
installation is complete, you have the option of launching Reason Lite directly.
The Reason Lite Rack Plugin VST3 is automatically installed in 
C:\Program Files\Common Files\VST3.
The Reason Lite Rack Plugin AAX is automatically installed in 
C:\Program Files\Common Files\Avid\Audio\Plug-Ins\

macOS:

1. Double click the Reason Lite installation file.

2. Follow the instructions on screen.
The Reason Lite Rack Plugin VST3 is automatically installed in 
Macintosh HD/Library/Audio/Plug-Ins/VST3.
The Reason Lite Rack Plugin AUv2 is automatically installed in 
Macintosh HD/Library/Audio/Plug-Ins/Components.
The Reason Lite Rack Plugin AAX is automatically installed in 
Macintosh HD/Library/Application Support/Avid/Audio/Plug-Ins

Both platforms:

• During the installation, the Authorizer application will be installed on your computer.
This application is necessary for handling the Reason Lite authorization (see below) and administration 
of Rack Extension devices.

The Authorization system
Reason Lite uses an authorization system designed to be as flexible as possible, while at the same time 
providing the best possible copy protection for the product. Here's how it works:

• The core of the authorization system is your license number, which is registered to your 
user account on the Reason Studios web site.

• If you have a working Internet connection you can then run Reason Lite with Internet Ver-
ification.
The program will then contact the Reason Studios web site and verify that Reason Lite is registered to 
your user account.

• If you don’t have a working Internet connection, you can run Reason Lite in Demo Mode.
In Demo Mode you can work as usual and even save your work. However, you cannot open songs in 
Demo Mode (for details, see “Running Reason Lite in Demo Mode”).

Registering Reason Lite
To be able to run Reason Lite in authorized mode (see “Running Reason Lite with Internet Verification”), 
the program must be registered to your account on the Reason Studios web site.

D Follow the instructions printed on the License card/sticker, to register Reason Lite.
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Running Reason Lite with Internet Verification
When you launch Reason Lite, the following window appears:

! Note that this requires a working Internet connection (and that your Reason Lite license 
has been registered to your user account as described in “Registering Reason Lite”).

D Enter the User name and Password for your Reason Studios account and click the Log in 
button.
Reason Lite now launches in authorized mode using Internet Verification.

! It is not possible to run two instances of Reason Lite (on different computers) authorized 
to the same user account. Reason Lite will then enter Demo Mode (see “Running Reason 
Lite in Demo Mode”).
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Running Reason Lite in Demo Mode
If you don't have a Reason Lite license, or if you don’t have a working Internet connection, you can run 
Reason Lite in Demo Mode:

1. Launch Reason Lite.
The following window shows up:

2. Click "Demo Mode".
Reason Lite launches in Demo Mode.
The Demo Mode indicator lights up to the right on the Sequencer Transport Panel:

Running Reason Lite in demo mode allows you to perform all operations as in authorized mode, with three 
exceptions:

• You cannot export audio or bounce mixer channels to disk.
• You will not have access to any additional Rack Extension devices (except for the in-

cluded ones).
• You cannot open songs.

The only songs that can be opened in demo mode are the dedicated demo songs (file extension 
“.reltdemo” (Reason Lite Demo Song)). Demo songs can be accessed from the “Open Demo Song” 
item in the File menu.

If you lose the Internet Connection while running Reason Lite with Internet Verification, the program will 
automatically enter Demo Mode. You can continue to work, and save your songs as usual. When you 
reconnect to the Internet, Reason Lite will automatically revert to authorized mode and the Demo Mode 
indicator will go off.
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About this Chapter
! This chapter is only relevant for the stand-alone version of Reason Lite. For Reason Lite 

Rack Plugin, no further setup is needed as the host DAW handles audio and MIDI connec-
tions.

This chapter describes the settings you need to make before you can start using Reason Lite. These are 
necessary in order to get any sounds to and from the program and to be able to play and control Reason 
Lite via MIDI.

First run - Reason Lite Setup 
Wizard
If you followed the instructions correctly in the last chapter, Reason Lite should be running, and the first 
dialog in the “Reason Lite Setup Wizard” guide should be open. 

This only appears the very first time the program is run.

! Note that the Language page only appears in the Windows version of Reason Lite. 
In macOS, the selected system language is used.
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! Note that any setting you make in the Setup Wizard can be changed later on in the Pref-
erences dialog.

D Clicking “Next” will take you through a series of dialogs, where the following happens:
• The Setup Wizard will first try to find a compatible audio driver.

It will automatically select the first compatible driver it finds. If this is the driver you wish to use, fine. If 
it isn't, select your preferred driver from the Audio Card Driver pop-up. If you don't know which driver to 
use, see “Setting up the Audio Hardware”.

• Next, Reason Lite will try to auto-detect a Master Keyboard.
If one is found, click "Next" to proceed.

! For Reason Lite to auto-detect a device you need two-way MIDI communication! Non-
USB keyboard devices without a MIDI input can of course still be added manually.

! Note that your keyboard model might not be auto-detected by Reason Lite, even though 
it’s a modern one and connects via USB. However, you can still use such a keyboard to 
control Reason Lite in the same way as with an auto-detected keyboard.

D Note that if you have additional remote control surface devices in your setup, these might 
have to be added in the Preferences - see “Adding a specific Control surface”.
The Setup Wizard will only establish a connected Master Keyboard device.

Setup is now complete!

If all went well, you should now have established audio and MIDI communication - the basics needed to 
record and play back audio and for controlling Reason Lite via MIDI!

However, if for any reason the Setup Wizard failed to establish the necessary settings, or if you wish to add 
other devices etc., you will have to make your settings in the Preferences dialog (see below).
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About the Preferences
The basic settings for audio and MIDI are done in the Preferences dialog. This is opened from the Edit 
menu (or, if you are running macOS, from the Reason Lite menu). 

The Preferences dialog.

q Described herein are only the most important settings in the Preferences. For informa-
tion about other Preferences settings, see the “Menu and Dialog Reference” chapter in 
the Reason Lite Operation Manual pdf.
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Setting up the Audio Hardware
In case this wasn't done in the Setup Wizard, you need to establish a connection between Reason Lite and 
the audio hardware. This is done by selecting a driver - a software component that acts like a link between 
the program and the audio hardware. Proceed as follows:

1. In the Preferences dialog, click the Audio tab.

2. Pull down the Audio card driver pop-up menu and select one of the available drivers.
Which driver to select depends on the platform and the audio hardware. If an option is not applicable to 
your setup it will be disabled in the dialog.
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macOS

D Select the option that corresponds to the hardware you want to use (the built-in audio 
connectors or some additional audio hardware that you have installed).

q A number of predefined combinations of built-in inputs and outputs will also be available 
in the Audio Card Driver pop-up.
The number of available input(s)+output(s) combinations depends of your computer’s specific audio 
hardware configuration.

Windows

! If you run Reason Lite under Windows, it’s required that the audio hardware supports 
ASIO drivers, otherwise you won’t be able to record any audio.

D Select the option that corresponds to the ASIO hardware you want to use.
If you are using audio hardware for which there is a specific ASIO driver, you should select this.
With an ASIO driver written specifically for the audio hardware, Reason Lite can communicate more or 
less directly with the audio hardware. The benefits are lower latency (see below) and possibly better 
support for additional hardware features such as multiple inputs and outputs.

About Latency and other Audio Settings

On the Audio tab, you will find a number of additional settings for audio. The most important ones are 
Buffer Size and the corresponding readouts for Input and Output Latency. 

The Input Latency is the delay between when the audio is “sent” from a connected microphone or 
instrument and when it’s received and detected by Reason Lite. Output Latency is the delay between when 
audio is “sent” from Reason Lite and when you actually hear it. The latencies in an audio system depends 
on your audio hardware, its drivers and their settings.

When you select a driver, its latency values are automatically reported by the audio card and displayed in 
the on the Audio tab in Preferences. Depending on the audio hardware and the driver, you may be able to 
adjust these values. If you experience high latency values, you will need to make adjustments to your 
configuration. 

D If available, use the Buffer Size slider to lower the latency.
The lowest buffer size setting you can choose depends on the audio drivers and your computer's per-
formance. If you get crackles and glitches during playback, the buffer size is set too low for your sys-
tem - you need to raise the buffer size until you can play back normally.

D If the Buffer Size slider is disabled, you may be able to lower the buffer size in the control 
panel for the audio hardware - click the Control Panel button to open this.

For more information, please consult the Reason Lite Operation Manual pdf.
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Setting up MIDI Control Surfaces
In Reason Lite, MIDI keyboards or remote control devices are called control surfaces. MIDI input from 
control surfaces can be handled by two systems: “Easy MIDI Inputs” and Remote. Here are some of the 
main features:

• You can use any number of control surfaces at the same time.
• The program supports a large number of control surfaces out of the box - knobs, faders 

and buttons on the surfaces are automatically mapped to the most useful parameters on 
the Reason Lite devices.
You don't have to change the settings on the control surface to control different devices in Reason 
Lite - if you change MIDI input from a ID-8 track to a Combinator track, the control surface will auto-
matically adapt. You just set up your control surface once and for all for use with Reason Lite - the pro-
gram handles the rest!

• For control surfaces that are not natively supported at this stage, you can use generic 
drivers.
Note however, that Remote drivers for additional control surfaces will be added continuously - check 
our web page for more info.

• By default, all control surfaces follow the sequencer Master Keyboard Input.
This means that you set MIDI input to a track in the sequencer to route the control surface(s) to the 
track's device in the rack.

• You can lock a control surface to a specific device in the rack.
For example, you could have a Master Keyboard that follows MIDI input, while another control surface 
is locked to the Main Mixer. This way you can control levels and pans at all times. This is described in 
the Operation Manual.

• You can use remote overrides to map a specific control on a surface to a specific Reason 
Lite parameter or function.
For example, you could override-map a knob or fader on your control surface to the Main Mixer's mas-
ter level fader. Or you could map buttons on your control surface to control Reason Lite's transport 
(play, stop, record, etc.) at all times, regardless of which track has Master Keyboard Input in the se-
quencer. This is described in the Operation Manual.

• Remote also supports some control surfaces with MIDI feedback.
If you have such a control surface and it is supported by Reason Lite, you can take full advantage of 
motorized faders, meters, displays, etc.

In case you specified a Master Keyboard in the Setup Wizard, and you don't have any other control 
surfaces, you don't have to do anything else. But if you want to add additional control surfaces or edit your 
settings, this is done in the Preferences.

Automatic set-up using the Easy MIDI Inputs function
By default Reason Lite automatically scans and detects all available MIDI In port(s) on your computer. If 
you have a MIDI keyboard or MIDI control surface connected to your computer, Reason automatically 
connects and lets you use it for controlling Reason Lite. This way you don’t have to do any manual set-up 
but can start controlling Reason Lite right away.
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At the bottom of the Control Surfaces tab in Preferences all currently available MIDI In Ports are listed:

All available MIDI In Ports on your computer are listed in the Easy MIDI Inputs list.

• The Easy MIDI Inputs function supports input of MIDI Note On/Off (with Velocity) as well 
as standard performance controllers, such as Mod Wheel, Pitch Bend and Sustain Pedal.
You can also do manual Remote Overrides to assign Reason Lite parameters to knobs/sliders/but-
tons on your control keyboard/surface. See the Remote chapter in the Operation Manual for more in-
formation.

D Deselect the Enabled box(es) to disable MIDI Ports you don’t want to be available for 
Reason.
For example, if you have a drum machine connected via USB to your computer, you might not want it 
to start sending MIDI Note data to Reason Lite, especially if it’s synced to MIDI Clock to Reason Lite’s 
sequencer.
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Adding a specific Control surface
If your specific MIDI keyboard/control surface model is featured in the list of supported surfaces in 
Reason Lite you will get even more functionality if you add it in the “Remote keyboards and control 
surfaces” section at the top - with knobs/sliders/buttons already pre-assigned to parameters in Reason 
Lite.

1. Open the Preferences dialog and click the Control surfaces tab.

2. If your control surface is connected via USB (or if you have made a two-way MIDI connec-
tion), try clicking the Auto-detect Surfaces button.
Reason Lite sends an ID request to all MIDI ports and checks for answers from any connected control 
surfaces. Note that not all control surfaces support auto-detection.

! If a MIDI Port of your connected control surface/keyboard is already used by the Easy 
MIDI Inputs function (see “Automatic set-up using the Easy MIDI Inputs function”), this detection 
will override this and automatically remove the MIDI In Port from the Easy MIDI Inputs 
list.

All found surfaces are listed in the Attached Surfaces list. 
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3. To add a control surface manually, click the “Add manually” button.
This brings up a new dialog.

4. Select the manufacturer of your control surface from the Manufacturer pop-up menu.
If you can't find it on the menu, see below.

5. Select the model of your control surface from the Model pop-up menu.
If you can't find it on the menu, see below.

6. An image of the selected control surface model is shown, often along with some informa-
tion text - read this carefully.
For some control surfaces, you need to select a specific preset to use the surface with Reason Lite - 
this is noted here.

7. Use the MIDI Input pop-up to select the input port to which you have connected the sur-
face.
If in doubt, you can click the Find button and then tweak a control or play a key on the control surface 
to have Reason find the correct input port for you.

• Some control surfaces may have more than one MIDI Input pop-up menu.
You need to select ports on all MIDI Input pop-up menus.

• Some control surfaces will have a MIDI Output pop-up menu.
In some cases this labeled "Optional" - then you don't have to make a selection. In other cases, a MIDI 
Output is required. This is the case if the control surface uses MIDI feedback - motor fader, displays, 
etc.

8. If you like, you can rename your control surface in the Name field.

9. Click OK to add the surface.
Depending on the surface model, alerts may appear, reminding you to select a specific preset etc.
In some cases, Reason Lite can restore a preset in the control surface to factory settings for you - you 
are then informed of this.

Finally you return to the Control Surfaces tab in Preferences, where your added surface is now listed.
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If your control surface model isn't listed

If you can't find your control surface listed on the Manufacturer or Model pop-up menus when you try to 
add it, this means that there's no native support for that model. However, the program supports generic 
keyboards and controllers. Here's what to do:

Select "Other" on the Manufacturer pop-up menu and then select one of the three options on 
the Model pop-up menu.

Or, if the Manufacturer is listed but not your specific model:

D Select one of the three "Other" options on the Model pop-up menu:

In both cases, the options are:

• MIDI Control Keyboard 
Select this if you have a MIDI keyboard with programmable knobs, buttons or faders. You need to set 
up your MIDI control keyboard so that the controllers send the correct MIDI CC messages, depending 
on which Reason Lite device you want to control - check out the MIDI Implementation Chart in the 
Reason Lite documentation. If your control surface has templates or presets for different Reason Lite 
devices, these can be used.

• MIDI Control Surface 
Select this if you have a MIDI controller with programmable knobs, buttons or faders (but without key-
board). Again, you need to set your controllers to send the correct MIDI CCs.

• MIDI Keyboard (No Controls)
Select this if you have a MIDI keyboard without programmable knobs, buttons or faders. This is used 
for playing only (including performance controllers such as pitch bend, mod wheel, etc.) - you cannot 
adjust Reason Lite device parameters with this type of control surface.

• MIDI Multichannel Control Keyboard/Surface
These options can be used if your MIDI keyboard or surface can handle multiple MIDI channels simul-
taneously.

After selecting a model, proceed with selecting MIDI input as described above.

About the Master Keyboard

One of the control surfaces can be the Master Keyboard. This is like any other control surface, but it must 
have a keyboard and it cannot be locked to a specific Reason Lite device (in other words, it always follows 
the MIDI input to the sequencer). This is the surface you use to play the instrument devices in Reason Lite.

• The first surface with a keyboard that is added (or found by auto-detect) is automatically 
selected to be the Master Keyboard.
This is shown in the Attached Surfaces list on the Preferences page.

D If you want to use another surface as Master Keyboard, select it in the list and click the 
"Make Master Keyboard" button.
You can only have one Master Keyboard.

D If you don't want to use any Master Keyboard at all, select the current Master Keyboard 
surface and click the same button (which is now labeled "Use No Master Keyboard").



SETTING UP28

Master Keyboard Input

This allows you to set a preference for how Master Keyboard Input mode is selected:

• Standard mode
This always sets Master Keyboard Input to the selected track.

• Separated mode
This will allow you to independently select tracks while Master Keyboard Input is unchanged. When 
this is mode is active, Master Keyboard Input is set by clicking the device icon in the track list. Select-
ing another track (by clicking on the track name or somewhere in the track list), leaves Master Key-
board Input unchanged.

Other functions

D To edit a surface, double-click it in the list (or select it and click Edit).
This lets you change its name and MIDI port settings, if needed.

D To delete a surface, select it in the list and click Delete.

D You can turn off a surface by deactivating its “Use with Reason Lite“ checkbox.
This could be useful if the surface is connected to your system but you only want to use it with another 
program, etc.

• There is also a “Sync” page in the Preferences.
This is only used for External Control MIDI buses and for MIDI Clock Sync. All hands-on MIDI control is 
set up on the Control surfaces page.
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Setting up the Default Song
It's possible to select a default Song which will automatically open as a “template” each time you select 
“New” from the File menu. The Default Song could be any Song you have created earlier, or a factory made 
Template Song. You can select this Default Song on the General tab in Preferences. 

1. Select “Preferences” from the Edit menu (Win) or “Reason Lite“ menu (Mac) and then 
click the General tab.

2. Click the "Template" radio button in the "Default Song" section. 

3. Click the folder icon to the right and select the Song you want to use as template when 
creating new Songs. 
Each time you create a new Song (by selecting "New" from the File menu), the selected Song will be 
loaded and used as a template for your new Song. On Windows platforms, the Song document will be 
named "Document n" where "n" is an incremental number. On macOS platforms, the document will be 
named "untitled n" where "n" is an incremental number. You can then save your Song with a new 
name.

Opening the last Song at program launch 
It's possible to instruct Reason Lite to automatically open the last Song each time you launch Reason Lite. 
You select this on the General tab in the Preferences dialog. 

1. Select “Preferences” from the Edit menu (Win) or "Reason Lite" menu (Mac) and then 
click the General tab. 

2. Tick the "Load Last Song On Startup" checkbox. 
When you launch Reason Lite the next time, the last saved Song will automatically open in a document 
window.
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Reassigning the Function Keys in 
macOS
When you work with Reason Lite, you will do a lot of navigating between the three main areas - the main 
mixer, the rack and the sequencer. The quickest way to switch between these areas is to use the function 
keys F5, F6 and F7 (see “Navigating between the areas” in the “Common Operations and Concepts” 
chapter in the Operation Manual and Help system for details). Also, the F2, F3, F4 and F8 keys are 
shortcuts for showing and hiding the Spectrum EQ window, Browser, On-screen Piano Keys window and 
the Tool Window, respectively.

However, on many Macintosh models (especially MacBooks), the function keys double as hardware 
control buttons. For example, they might control the volume of the built-in speaker, the display brightness 
or keyboard backlight. To make these keys actually work as function keys for software such as Reason 
Lite, you need to hold the "Fn" key while pressing them.

This can work perfectly OK, but to get the best workflow in Reason Lite we recommend that you change 
this behavior, so that pressing e.g. the F5 key actually sends "F5" to Reason Lite (and you hold down the 
Fn key to get the hardware control functions instead). Here is how you change this:

1. Open the System Preferences in macOS and select the "Keyboard" item.
The "Keyboard" preferences are shown.

2. Select the "Keyboard" tab and make sure the checkbox "Use all F1, F2, etc. keys as stan-
dard function keys" is ticked.
Now you can use F2-F8 for controlling functions in Reason Lite. To use hardware control features 
such as volume and display brightness, you need to hold down the "Fn" key before pressing the func-
tion keys.

Some function keys might also be pre-assigned to macOS keyboard shortcuts, which will have priority over 
software such as Reason Lite. This is easily changed:

3. Click the “Keyboard Shortcuts” tab in the “Keyboard” window.
The Keyboards Shortcuts Preferences window shows lists of keyboard shortcuts assigned to system 
functions. For example, [Cmd]-[F5] in the Accessibility group is assigned to turn VoiceOver on or off. In 
Reason Lite, this is the keyboard shortcut for detaching the main mixer into a separate window.
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4. Scroll down to the "Turn VoiceOver on or off" item in the Accessibility group and either 
remove the tick from the checkbox or assign it to another keyboard shortcut.

5. Now, you’re finished with the settings and can close the “Keyboard” window.
From now on, the function keys and keyboard shortcuts will perform their intended functions in Rea-
son Lite.
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